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Quick Tour of Your Online Mailbox - Message List
When you first open your prodigy online mailbox, a window will be displayed listing all messages as well 
as the date and time received, the sender, the subject, and information on the type of message. prodigy 
mail uses standard windows menus and windows keyboard and mouse navigation. As you move your 
mouse over mailbox features (the buttons across the top of the window shown below) the cursor will 
change to a hand, indicating that you can jump to a topic that describes what feature the current icon on 
the toolbar accesses or other important information about screen area under the cursor. 

The screen above shows an online mailbox after a message has been opened.    Click on a feature to 
learn more about it. If new mail arrives while you are using your prodigy mailbox, the UPDATE icon will 
change to a NEW MAIL icon.

UPPER WINDOW: The STATUS of each message is shown by the message type icon indicators. The 
date and time the message was received in your online mailbox is shown, as well as the subject. A file 
attachment will show the name of the file and the size of the file in bytes. 

LOWER WINDOW: The body of an opened Email message is displayed in the lower window. Use the 
scroll bars and or the splitter bars to view more of the message OR use the ZOOM IN icon to expand to 
single message view.

FILE ATTACHMENT ICONS: In the example above, file attachment icons are displayed (the default). To 
retrieve a file, double click anywhere on the attachment line.

See Also:
Message List View



Opening a Message
Saving a Message to a File on Your Hard Drive
Printing A Message
Deleting a Message
Retaining a Message
ZOOM in and ZOOM out
Additional Mail Info
How to Navigate to the Next Message
How to Navigate to the Previous Message
Updating the List of Messages
Using the Scroll Bars to Navigate
Using the Splitter Bar to Change the Window Size
What the Message Type Icons Mean
Status Bar Messages
Clear Dialog Window



Message List View
Before you select a message from your mailbox, you are first shown the list of all messages currently in 
your mailbox. There are a variety of ways to navigate with the mouse and/or the keyboard and you'll 
quickly find the way that works best for you. You'll learn more about each feature as you explore prodigy 
mail menus and this help file.



 Open a Message
Click on the message you wish to open (read) to highlight it and then click on the OPEN icon to display 
the message.



 Save a Message to Disk
To save an open message to disk, make sure the message is highlighted and then click on the SAVE icon
to save the current message to a file on your hard drive.



 Print A Message
To print the current opened message, click on the PRINT icon.



 Delete a Message
Click on the message you wish to delete to highlight it and then click on the DELETE icon to mark the 
message for deletion.



 Retain a Message
Click on the message you wish to retain to highlight it and then click on the RETAIN icon to mark the 
message to be retained.



 Zoom In and 

 Zoom Out
The ZOOM IN icon takes you from the mailbox listview to an expanded single message view. ZOOM OUT
will appear on the toolbar to replace ZOOM IN and works as a toggle to quickly switch you between 
expanded ZOOM IN mode and mailbox listview mode.



 Mail Info
Click on a message to highlight it and then click on the MAIL INFO icon to display additional information 
about this message.



 Write a New Message
Select this icon to compose a new message.



 Reply to a Message
Select this icon to reply to the current open message.



 Forward a Message
Select this icon to forward the current message to another Email address.



 Attachments to Messages
Select this icon to toggle the display of file attachment icons on or off. When show file attachment icons is 
"on" (this is the default), you will be able to see special icons representing Windows WAV files and JPEG 
image files. All other messages will display a generic disk icon indicating a file. Click on the link above to 
view help on starting a file download.



 Next Message
Select this icon on the Toolbar to navigate to the next message in your mailbox.



 Previous Message
Select this icon on the Toolbar to navigate to the previous message in your mailbox.



 Update Mailbox
Select the UPDATE MAILBOX icon to refresh the list of current messages in your online mailbox.



 Address Book
Select this icon to access your Address Book.



Scroll Bars
Use your mouse to click on the arrows on the scroll bars to display additional messages or view 
information not currently displayed on your screen.



Splitter Bar
The splitter bar lets you change the size and spacing    of the upper and lower display areas. 



Message Type Icon Indicators
Various graphic icons display additional information regarding the status of a message and the types of 
messages in your online mailbox.



Status Bar Information
The status bar displays information about the currently selected message or displays a confirmation that a
function has been completed.



Opening a Message
Selecting the OPEN icon from the toolbar will open the highlighted message. You can highlight the 
message you wish to open by moving the cursor over it with the arrow keys and then pressing [Enter], or 
you can highlight a message with the arrow keys and then select the File Menu and then Open. Double 
clicking on any message in your mailbox will also open the message.

Hotkey: CTRL+O



Saving a Message to a File on Your Hard Drive
After you open a message you can save it as a file on your hard drive by selecting the SAVE icon from 
the toolbar. You can also save a message by selecting the File Menu and then Save Message.

Hotkey: ALT+F, S

A standard windows File Save dialog window will display. prodigy mail will suggest a file name and will 
automatically save the file in the same directory where the prodigy mail program files are installed (a 
subdirectory named pmail under the directory where prodigy for Windows is installed). You can change 
the file name by highlighting the name shown and typing a new name over it. You can also change the 
directory where the file will be placed using standard Windows navigation.



Printing A Message
An open message may be printed by selecting the PRINT icon from the toolbar. You may want to first visit
PRINT SETUP (File, then Print Setup) before printing your first message from prodigy mail if you have 
more than one printer and/or a fax modem which is set up as a printer.

Hotkey: CTRL+P



Deleting a Message
After you highlight a message and select the Delete icon, it is marked for deletion and a new trashcan 
icon will appear in the list box. Messages are not deleted until you leave or update your mailbox. If you 
change your mind, highlight the message again and select the Delete icon (this works as a toggle). You 
can range or multi select a group of messages to delete using standard windows mouse and keyboard 
combinations. SHIFT+LEFT MOUSE will select a contiguous group of messages. CONTROL+LEFT 
MOUSE will select a non-contiguous group of messages in any order. Both routines will highlight a group 
of messages. When you have completed selecting a group of messages to delete, click on the Delete 
icon.

Hotkey: CTRL+D



Retaining a Message
After you highlight and select the Retain icon, the message is marked for retention an additional 14 days 
and a new retain icon will appear in the list box. When you leave you mailbox or select Update mailbox, 
the retain instruction will be transmitted to the prodigy network. 

You can range or multi select a group of messages to retain using standard windows mouse and 
keyboard combinations. SHIFT+LEFT MOUSE will select a contiguous group of messages. 
CONTROL+LEFT MOUSE will select a non-contiguous group of messages in any order. Both routines will
highlight a group of messages. When you have completed selecting a group of messages to retain, click 
on the Retain icon.

Hotkey: CTRL+E



ZOOM in and ZOOM out
After you open a message, if you wish to see more of the current message without using the scroll bars 
as often, you can select ZOOM IN to enter a wider display area mode. (At this point the icon changes to 
Zoom Out.) Any portions of the message still out of view can be access by using the scroll bar or your 
page down/page up keys. ZOOM OUT will return you to the mailbox list view.

Hotkey: CTRL+SHIFT+Z



Additional Mail Info
Select the Mail Info icon to view additional information about the sender of the message, the date and 
time it was received in your mailbox and to add the sender to your online address book. A new window 
will display.

The information displayed lets you know the date and time the message was sent to your prodigy 
mailbox,    then name of the sender and their prodigy ID or internet Email address. Additionally, the subject
of the current message and the date this message is scheduled for deletion is shown. You can navigate to
the previous message or the next message, or add the sender of this message to your address book by 
clicking on a button in this window. When you are finished, select the Close button to close this window.



How to Navigate to the Next Message
When you first arrive at your online mailbox, a list of messages is displayed. Before you open a message,
click on the NEXT MESSAGE icon to highlight the next message on the list. Before any messages are 
opened, you can also use the cursor (arrow) keys to move between messages. 

If you have already opened a message and wish to navigate to the next message in your mailbox, select 
the NEXT MESSAGE icon. If you have ZOOMED IN to see more of the current message, you can still 
navigate to the next message by selecting the NEXT MESSAGE icon.

Hotkey: CTRL+PgDn



How to Navigate to the Previous Message
To navigate to the previous message in your mailbox, select the PREVIOUS MESSAGE icon on the 
prodigy mail toolbar. If no messages are currently open, and if you have navigated to the second or 
succeeding message(s) in your mailbox, you can also use the cursor (arrow) keys to go to a previous 
message.

If you have already opened a message and have ZOOMED IN to view more of the message on your 
screen, you can navigate to the previous message by selecting the PREVIOUS MESSAGE icon.

Hotkey: CTRL+PgUp



Updating the List of Messages
If you spend some time in your mailbox reading, deleting, and retaining messages, you can refresh the list
of messages by selecting the UPDATE MAILBOX icon. When you do this, messages marked for deletion 
will be removed from your mailbox at this time and the instruction to retain messages marked for retention
during the current session will be transmitted to prodigy. 

Hotkey: CTRL+M



Using the Scroll Bars to Navigate
Depending on the size of your monitor and what resolution you use to run Microsoft Windows, there will 
be occasions where either (or both) the list of messages in your mailbox or the text in the 
subject/information line does not fit in the viewable image are. When this condition exists, the windows 
scroll bar should be used to navigate up or down in the list of messages or to view the entire 
subject/information line for an individual message. 



Using the Splitter Bar to Change the Window Size
To change the relative sizes of the upper and lower window while in the mailbox listview (so you can see 
more of the list or more of the current opened message) use your mouse to drag the splitter bar to a 
different location on your screen.

Press and hold your left mouse button (the cursor will change to a double headed arrow) on the thin line 
in the splitter bar (circled above) and then drag it up or down to change the position. When you are happy 
with the relative sizes of the upper and lower window, release the left mouse button



What the Message Type Icons Mean
To the left of each message in your mailbox one or more icons display information on the status of the 
message (read or unread), and additional icons indicate if a RETURN RECEIPT was requested, and if the
sender has designated the message as URGENT. A message marked URGENT is not delivered any 
faster than one that is not marked urgent, the URGENT marker only indicates that the sender wishes you 
to consider the message as a top priority.

File attachment icons are used to display information as to the type of file attached to the message. 
Windows WAV files will display a special sound icon indicating that they can be played online as well as 
downloaded and played offline. JPEG image files will display a special image icon indicating that the 
JPEG image may be viewed on line. JPEG images may also be downloaded and viewed offline if you 
already have a JPEG image viewing program. (prodigy members who use the prodigy web browser can 
find a program called imagview.exe in the directory where prodigy for windows was installed that can be 
used to view JPEG images offline. 

Click on each icon below for an explanation of each message type indicator.



Message has not been opened
This message has not yet been read. After you open the message, the icon will change to indicate the 
message has been opened.



Message has been opened
This message has been opened. You cannot change the status of an opened message. You can re-read 
an opened message until it is deleted from your online mailbox.



Message has been marked to be retained
After you open a message, it will automatically be deleted after three days. You may retain a message for 
an additional 14 days by selecting the RETAIL icon from the toolbar. A new icon indicating the message 
has been marked to be retained appears adjacent to the message. If you change your mind, highlight the 
message and reselect the RETAIN icon which will unmark the message to be retained. You can change 
your mind and toggle RETAIN on and off until you select the UPDATE icon, or until you select the NEW 
MAIL icon    on the toolbar if new mail arrives while you are using your online mailbox. If you exit your 
online mailbox, the UPDATE function is automatically performed at the time you exit.



Message has been marked for deletion
After you open a message, it will be automatically deleted after three days. You can delete a message at 
any time (whether you have opened it or not) by highlighting the message to select it and then selecting 
the DELETE icon on the toolbar. An icon appears indicating the message is marked for deletion. You can 
change your mind and toggle DELETE on and off until you select the UPDATE icon, or until you select the
NEW MAIL icon on the toolbar if new mail arrives while you are using your online mailbox. If you exit your
online mailbox, the DELETE function is automatically performed at the time you exit your mailbox and the 
message(s) marked for deletion will no longer be available to you.



A File Attachment is available for download
This icon indicates that a file is attached to the this message. The attached file can be any type of file 
except a Windows WAV or JPEG image file, as these two special file types have their own unique icon 
indicators.



A JPEG image file is attached
This icon indicates that a JPEG image file is attached. You can view the file online and/or download to 
your hard disk and view it offline.



A Windows WAV file is attached
This icon indicates that a Windows WAV file is attached. You can play the file online if you have a 
Windows compatible sound card and/or you can download the file to your hard disk and listen to it offline 
(again, if you have a sound card).



Carbon Copy
The message was sent to another Email address(es) and you have been sent a copy.



Blind Carbon Copy
The message is a blind carbon copy of a message that was sent to one or more other Email addresses.



Urgent Message
The sender of the message feels this message should be read as a top priority. 



Return Receipt Requested
The sender has requested and will receive a receipt after you have opened the message. A receipt does 
not indicate that the message has been read, only that it was opened.



New Message
This icon indicates that the message was received since the last time you visited your online mailbox.



Status Bar Messages
The status bar in your prodigy mailbox displays information that lets you know the progress of a file 
transfer, the download of a long message, and while the message list is being retrieved, the number of 
total messages in your mailbox and the progress retrieving these messages (for example: 3 of 52 
messages loaded). Additionally, the status bar displays information when you delete, retain, or request a 
receipt of a message. 

In the example above, a message was marked to be deleted and the status bar displays the date the 
message will be deleted.



Clear Dialog Window
There may be times that you decide to make changes to a message before transmitting it. The Clear 
Dialog window lets you control what you want to change. 

If you have NOT enabled RETURN TO MAILBOX AFTER SEND in PREFERENCES, you can use the 
Clear Message Window to send a different message to the same group of people, send different 
attachments to the same groups of people, send a new message to the same group, or to send the SAME
message to different recipients. 

You can mark and unmark by clicking in each field whether to clear the To List, CC List, Subject, Message
Text, etc. or you can SELECT ALL to clear ALL fields. When you have finished, select OK to return to the 
message window and keep the changes or CANCEL to return to the message window without making 
any changes.



Writing, Forwarding, and Replying to Incoming Mail
Writing, Replying, and Fowarding prodigy mail all use the same types of windows, icons, and keystrokes. 

If you're replying to a message, the TO: field will be displayed with the ID or Email address already 
entered for you. When you're replying to a message, you can add additional recipients, cc's and blind cc's
using the same steps as when you are writing or forwarding Email.

If you're writing a new message or forwarding a message from your online prodigy mailbox, type in a valid
prodigy ID, Internet Email address or nickname and then press the [Enter] key. Or, select a name from 
your address book using the SELECT icon on the toolbar. This opens the Select From Address Book 
window so you can add one or more recipients, cc's, etc. Type a subject in the subject field and then [Tab]
to the main message window field or click your mouse in the message field. You're now ready to start 
typing the body of your message.

After you type a prodigy ID, internet Email address or nickname already entered in your address book and
press [Enter], the name will appear in the list box below the To: field.    (You can also type cc and bcc 
prefixes here). If you type an invalid nickname or prodigy ID, an error message will be displayed. When 
you're done entering Email addresses, click in the Subject field or use the [Tab] key to navigate there. (A 
Subject is not required, you can skip this step and proceed to typing the body of your message). Click in 
the message body field or use your [Tab] key to navigate there from the Subject field.

Next, type the message. You can add additional text by using IMPORT, or you can IMPORT the entire 
message. If you wish to    send a file, select the ATTACH icon on the toolbar.. You can SAVE the message
to disk before sending by selecting the Save icon, PRINT the message to your printer, add more 
recipients using the SELECT button, and SPELL CHECK the message before you press the SEND 
button.

You can flag the message as URGENT by clicking in the Urgent checkbox. If you wish to receive a receipt
in your prodigy mailbox when the recipient(s) opens the message, you can mark the message RETURN 
RECEIPT requested by clicking in the RETURN RECEIPT checkbox.

When you're ready to transmit your message, click on the SEND icon on the toolbar.



Use the CLEAR icon to display the CLEAR OPTIONS dialog window.



CC's and BCC's
You can designate cc's and bcc's (carbon copies and blind carbon copies) by typing a prefix in the TO 
field.

Type cc: to designate a carbon copy (EXAMPLE cc:PROD94A).

Type bcc: to designate a blind carbon copy (EXAMPLE bcc:PROD94B).

prodigy mail will automatically designate these as cc's or bcc's and show cc's on the distribution list (bcc's
will NOT appear).



Attaching Files
When you want to attach one or more (up to three) files to an outgoing message, selecting the ATTACH 
icon displays the standard Windows File Select window. Navigate to the directory or drive and directory 
where the file you wish to attach is stored on your hard drive and then double click the file (or highlight it 
and then select OK).

If the file you wish to send is a Windows WAV or JPEG image file, you can preview the file before you add
it to the attachment list by highlighting the file and then selecting the PREVIEW button in the attachments 
window. (A file that is not a WAV or JPG file will not display and you will receive an error window). The file 
name, size, and location on your computer is shown and the total size of all attachments is shown below 
the file name window. You can add (up to three) attachments by selecting the ADD button. If you wish to 
remove a file from the list of attachments to send, highlight it and then select the DELETE button. (This 
doesn't delete the file from your pc, it only removes it from the list).

When you have completed selecting files to send, click on OK to return to your mailbox. If you decide not 
to send any attachments, click on CANCEL.



Address Book
Your online prodigy address book can contain 50 prodigy ID's and 50 Internet Email addresses. From the 
nicknames in your online address book, you can create two mailing lists of 20 names each. prodigy mail 
displays <<Mailing List>> as the address when the nickname represents a mailing list and not an 
individual address.

Move your mouse over the image below. When the mouse pointer changes to a hand, click to 
select more information about that feature.

See Also:
Adding Entries to your online Address Book
Creating a Mailing List
Select From Address Book



Nickname
prodigy mail uses nicknames as 'aliases' for prodigy ID's, Internet Email addresses, or Mailing Lists to 
make it easy for you to compose mail. Once you have established an entry in your address book, you can
address a message by typing this nickname into the TO field in write, reply, and forward. 



Address
The address that corresponds to the nickname you entered is shown next to each nickname. 



Add Entry
To add an entry to your online address book click on ADD ENTRY to display the Address Entry window.



Create List
To create a mailing list, Click on CREATE LIST to display the Create Mailing List window.



Change
To change an entry, highlight it and click on CHANGE. This will display the ADD ENTRY window and 
allow you to make changes.



Delete
To delete an entry from your address book, click on DELETE.



Adding Entries to your online Address Book
To add a prodigy ID to your address book, carefully type the full prodigy ID into the ID/Address field and 
select a nickname. Make sure that prodigy ID is marked under Address Type and then select OK. prodigy 
mail will verify that this is a valid ID and display an error window if the ID you typed is incorrect.

To add an Internet Email address to your address book, first click in the Internet Address field under 
Address Type to change if from prodigy ID to Internet. Next, enter a nickname and then carefully enter the
full internet address in the ID/address field.    If you don't know the correct format to send Email over the 
Internet to someone on another online service, just click on the Examples button for samples.



Creating a Mailing List
Before you can create and store a mailing list in your online address book, the individuals you wish to 
include in the list must already be entered in your address book. A prodigy mail mailing list can contain up 
to 20 nicknames which can be any combination of prodigy ID's and Internet Email addresses. 

First, type a Mailing List Name in the space provided. Next, highlight the names you wish to include on 
this mailing list. You can range select a group of names by using SHIFT-CLICK for contiguous entries or 
CTRL-CLICK for non-contiguous entries. When you have finished selecting names, click Add.

To remove and entry, highlight it and then click on the Remove button. The number of entries out of the 
maximum of 20 changes as you add or remove entries and is displayed for you. You can remove ALL 
entries from the mailing list by clicking on the Clear All button. When you have finished creating your 
mailing list, click on the OK button and the information will be transmitted and saved. If you change your 
mind, click on Cancel to return to your address book.

File attachments can not be sent to internet destinations and if you attempt to send a file to a mailing list 
that includes an Internet Email address, a warning message will appear to remind you.



Select From Address Book
prodigy mail offers you an easy point and click way to address your outgoing mail. When you use the 
Select from Address Book dialog window, you have many options available.

The image below contains hotspots. Move your mouse over the image and click when the cursor 
changes to a hand to learn more about the feature.

You can range select a group of names using SHIFT-CLICK or CTRL-CLICK and then select the Send To 
(or Remove) button to quickly move a group of names back and forth on the TO/CC list. If you want to 
designate someone to receive a copy marked as a "Carbon Copy" (as opposed to a TO or main 
recipient), select a name or group of names and then click Send CC. A CC usually means that no action 
or response is required, and the message is just for informational purposes only. In addition, you can 
designate BLIND CC's where the recipient receiving a BLIND CC will not receive a distribution list 
showing the addresses and others who received this message and where those receiving the message 
will not see who received a BLIND CC.

The number of prodigy Ids and Internet Addresses in the TO/CC list changes as you add or remove 
recipients and is displayed beneath the TO/CC List window.



Select Nicknames
Click on one or more nicknames and then click on the Send To button to place these names on the 
TO/CC list. You can range select using SHIFT-CLICK or CTRL-CLICK.



TO/CC List
The nicknames in this window will receive the current message. You can highlight one or more names 
and then click the Remove button to remove select names from the TO/CC list.



Send CC
Select one or more nicknames and then select the SEND CC button to designate addresses to receive 
copies of the current message showing    that the message is a Carbon Copy (and not a 'main recipient).



Remove
Highlight one or more names in the TO/CC window and then click the REMOVE button to take these 
nicknames off the list of people receiving the current message.



prodigy ID or Internet Address
You can add recipients, CC's or BCC's who are currently NOT in your online address book by using this 
field. Type a prodigy ID or Internet Email Address in this space and then click either the SEND TO or the 
SEND CC button to place these addresses in the TO/CC window.

You can also manually type cc: before the ID to designate the recipient to receive a copy marked CC.

To send a BLIND CARBON COPY, type bcc: and then the prodigy ID or Internet Email address.



Distribution Lists and Mailing Lists
You can store two mailing lists in your online prodigy mail address book. Detailed    information on mailing 
lists is available.

A distribution list can be created 'on the fly' for each message and is not retained in your online address 
book. The quickest way to complete an 'on the fly' distribution list is to use the Select From Address 
Book window which lets you select from nicknames already in your address book and lets you add 
names to the list that are not currently in your address book as well. 

Detailed information on adding prodigy ID's and/or internet Email addresses to the distribution list is also 
available. 



prodigy mail Menus
In addition to easy mouse navigation, prodigy mail functions can be accessed from the menubar (and 
many functions have hotkeys as well). You'll soon discover which means of navigation works best with the
way you use Windows. 

See Also:
File Menu
Edit Menu
Options Menu
Mail Menu
Goto Menu
Help Menu



File Menu

From the File Menu (ALT+F), you can open a message in your mailbox by highlighting it and then 
selecting Open Message (or use CTRL+O).

Select Save Message to save a message to a file on your hard drive (ALT+F, S)

Select Print Setup to change your printer or printer settings (ALT+F, R)

Select Print to print the current opened message (CTRL+P)

Select Print Mailbox to print the list of messages in your mailbox (CTRL+P)

Select Exit to leave prodigy mail. (ALT+F, X)



Edit Menu

From the Edit Menu (ALT+E) options are available depending on what type of mail window is the current 
active window.
Select Cut to delete highlighted text (CTRL+X)
Select Copy to copy highlighted text to the clipboard (CTRL+C)
Select Paste (CTRL+V) to paste text already on the Windows clipboard into the current message. 
Select Clear (ALT+E, E) to display the CLEAR dialogue window.



Options Menu

The Options Menu (ALT+O) lets you customize the way prodigy mail works on your computer. 
While in the mailbox listview window, you will be able to access both Preferences and Fonts. While 
reading or writing mail, you will be able to access the Fonts Menu only.
Select Preferences to display the Preferences Dialogue Window (ALT+O, R).
Select Fonts to specify which font to use in prodigy mail windows (ALT+O, F).



Mail Menu

Depending on whether you are viewing the list of messages in your online mailbox or replying, forwarding 
or writing a new message, selected functions are available from the Mail Menu (ALT+M).
The Menu on the left is available when you are viewing the mailbox list of messages, while the menu on 
the right is available while you are replying, forwarding, or writing a new message.
MAILBOX LIST MAIL MENU:
Select Write New Message to open a Write window (CTRL+W)
Select Reply to Message to reply to the current message (CTRL+R)
Select Forward Message to send the current message to another Email address or prodigy ID (CTRL+F)

Select Delete Message to mark a message to be deleted (CTRL+D)

Select Retain Message to retain the current message an extra 14 days (CTRL+E)

Select Next Message to navigate to the next message (CTRL+PgDn)

Select Previous Message to navigate to the previous message (CTRL+PgUp)

Select Zoom In/Out to expand the viewable text or return (CTRL+Shft+Z)

Select Mail Information to view additional information about the sender (CTRL+I)

Select Update Mailbox to clear your list of items you have marked for deletion and transmit retained 
message markers (CTRL+M)

Select Address Book to access your online address book (ALT+F, B)

WRITE-REPLY-FORWARD MAIL MENU:

Select Send Message (CTRL+S) to transmit the message in the message edit window.

Select from Address book allows you to add recipients you already have entries for in your online 
address book.

Select Urgent to place a checkmark in the Urgent checkbox to flag the message as important (ALT+M, U)

Select Return Receipt to receive an acknowledgment that the message was opened by the recipient. 
(ALT+M, R)

Select Zoom In to use a larger edit window (ALT+M, Z)

Select Return to Mailbox to leave the message editor and return to the list of messages in your online 
mailbox (CTRL+M)



Goto Menu

The GoTo Menu provides a quick way to navigate to other messaging features or to the highlights screen.
When you select any of these menu choices, a window will display asking you to confirm you wish to 
close prodigy mail and navigate to the feature you have selected.
Select Mail Manager to navigate to the online application that lets you download mail to your offline mail 
software (CTRL+G)
Select Member List to look up or find an ID for a prodigy member. (CTRL+L)
Select Greeting Cards to select a greeting card to send to a prodigy member (CTRL+T)
Select Highlights to go to the prodigy general highlights screen (CTRL+H)



Help Menu

prodigy mail help is context sensitive. In many areas, pressing F1 will display help on the function you are
using (if not, F1 will display the Help Contents Menu). 
Select Contents to display the Help Contents.
Select Search for Help On to display the search word window. Enter a word that best describes the area 
you are looking for help on. A large number of keywords have been indexed to make it easier for you to 
find help quickly.
Select About Mail to display information about the version of prodigy mail you are currently using.



New Mail
When you first logon to prodigy, if new mail has arrived since your last session, you will find a new mail 
icon on your prodigy toolbar and if you have enabled sound and specified a WAV file, you will hear the 
new mail notification.

If new mail arrives while you are in your prodigy mailbox, you'll also see the UPDATE icon change to the 
NEW MAIL icon on your prodigy mail toolbar.



Incoming Files (File Attachments)
The procedure for saving an incoming file attachment to your hard drive is the same for all file types, 
whether the file is a Windows WAV file (*.WAV), a JPEG image file (*.JPG), an ASCII text attachment 
(*.TXT), or any other type of binary file. 

Windows WAV files:

When the incoming file attachment is a Windows WAV file, and you wish to download (and optionally play 
the WAV file from your online mailbox after the file has been downloaded), double click on the file 
attachment icon and a File Save dialog window will be displayed with the name of the file already entered 
for you:

You can save the file to the displayed current drive and directory, or you can change the directory (and the
drive if you want to) as well as the file name using standard Windows navigation. If a file of the same 
name already exists, a new warning window will display:

Select Yes to replace the file or No to go back and change the file name, change to a different directory, 
etc. Once you REPLACE a current file with a new file of the same name, you will not be able to recover 
(or undelete) the previous file, so it's a good idea not to replace/overwrite unless you are certain you will 
not need the original file again.

JPEG Image Files:

When the incoming file attachment is a JPEG (*.JPG) image file,    and you wish to    download (and 
optionally view the JPEG file online after the download has completed), double click on the file attachment
icon and a File Save dialog window will be displayed with the name of the file already entered for you:



You can save the file to the displayed current drive and directory, or you can change the directory (and the
drive if you want to) as well as the file name using standard Windows navigation. If a file of the same 
name already exists, a new warning window will display. 

OTHER FILE TYPES: 

prodigy mail displays the Save File Attachment window for files other than WAV and JPG and 
automatically displays the file name for you when you double click a file attachment icon to save it to disk:

The procedure to save any binary file to your hard drive is the same as for a WAV or JPG file, but you will 
have to use or view the file offline.

IMPORTANT:

Make sure you have a program to view or run a file you save to disk. Treat all incoming files with caution. 
prodigy services company is not responsible for the contents of any file you download to your hard disk 
nor can it be responsible for knowing whether or not the file is a valid file, if it will run properly or how it will
behave on your computer. 



Importing Text
In prodigy mail, you can place up to approximately 30,000 bytes (also known as characters) of ASCII text 
in the body of a message. Text that exceeds this amount should be sent as a File Attachment. 

The *.txt extension is displayed as the default. If you wish to select from ALL files, click on the down 
arrow in the List Files of Type listbox and select ALL files which will display all files (*.*).

IMPORT A FILE uses a standard Windows FILE SELECT dialog window. If the file you wish to import is in
the current directory, select it in the upper left window by double clicking on it or by highlighting it and then
clicking on OK. If the file you wish to import is on the current DRIVE but in another directory, double click 
on the directory name to display its contents and then select the file you wish to import. (Click on the 
parent directory folder icon C-D-E etc.) to display the directory list for that drive). If the file is on a different 
drive, select the drive from the Drives drop down list box by clicking on the down arrow and then select a 
different drive. Next,    select the directory and then the file and finally click on OK.



Advanced Options
prodigy mail users can sort their mailbox with the newest message on top or the oldest message on top 
using the Preferences window and can determine whether or not to return to the mailbox list view after 
replying to an incoming message.

If you use offline Email software, such as Email Connection, you can navigate to the online screen that 
lets you GET/SEND mail from the prodigy mail GoTo menu.

See Also:
Preferences
Changing the Font
Downloading to your offline mail software
Greeting Cards
Commercial Mail



Preferences

You can specify whether you wish to return to the mailbox listview after you send a message or to 
remaining the compose a message window with the message you have just sent still displayed. If you do 
not select return to mailbox after send, the option to remain in the compose a message window offers you
the additional opportunity to select the CLEAR feature and resend the message to a different address, 
resend a different message to the same address, etc. See the CLEAR help for the list of options.

Your mailbox is sorted for you by default with the newest message at the top of the list so that you always 
see the newest message when you visit your online mailbox. You can sort your mailbox so that the oldest 
mail appears at the beginning of the list and the newest mail appears at the end of the list by clicking in 
the check box to mark REVERSE SORT MAILBOX. 

When you have completed making changes, select OK to return to your mailbox or Cancel to return 
without implementing any changes.



Changing the Font
The default font displayed for    message text when you use prodigy mail for the first time is your 'system 
font'. It is a matter of personal taste which font is the most pleasing to use. If you wish to change the font 
used to display the body of a message, select the Options Menu and then Fonts from the mailbox listview.

A standard window Font Selection box will display.

Select the Font Name first and then decide which style and size you'd like to try. When done select OK. If 
you find that you don't like your select, just return to the Options/Font menu and select a different font.

Note that you cannot change the font size in the list of messages or in the TO or SUBJECT fields.



Downloading to your offline mail software
You can easily use prodigy mail in conjunction with your offline mail software (such as Email Connection) 
by selecting the GoTo Menu in prodigy mail and then Mail Manager which automatically closes prodigy 
mail and lets you go to the online application to download mail. 

If you logon to prodigy using your offline software and use the option to remain at the mail manager online
screen when done, you can select the MAIL BUTTON if you want to visit your online mailbox to view a 
Greeting Card or Commercial Mail message.



Greeting Cards
When you open a Greeting Card in prodigy mail, the prodigy mail application is automatically minimized 
for you and then the card you have received is displayed. 

When you're ready to return to your online mailbox, select the RETURN TO MAIL button on the greeting 
card and prodigy mail will re-open automatically and display the message the sender wrote in the lower 
window below the splitter bar. You can then reply to a greeting card by selecting the reply icon on the 
prodigy mail toolbar and you'll have a quick reference to any message text from the sender.



Commercial Mail
When you open a Commercial Mail message from one of our advertisers, the prodigy mail application is 
automatically minimized for you.

When you're ready to return to your online mailbox, select the RETURN TO MAIL button and prodigy mail
will re-open automatically. 



Playing WAV Files
After you have downloaded a Windows WAV file to your hard drive, you can listen to the file online if you 
have a sound card on your system. prodigy mail will automatically display a window asking if you wish to 
hear the downloaded sound. Select Yes and the WAV file will be played, or select no to return to your 
mailbox.

Note: to listen to WAV files offline, you will need an external program. Many Windows systems come with 
soundrec.exe (which you will find in the directory where you installed Windows) which can be used to 
listen to the WAV file offline.



Viewing JPEG Image Files
After you have downloaded a JPEG image file to your hard drive, you can view the file online. A special 
viewer was supplied with prodigy mail that lets you do this when you select Yes in the preview picture 
dialog window.

Note: You can view a *.JPG image file offline if you have an external image viewing program available 
which can display this file format. prodigy web browser users will find a program in the directory where 
prodigy for Windows is installed called imagview.exe that can be used for this purpose.



Using the Spell Checker
prodigy mail includes a spell checker and comes with a standard dictionary. You can easily add any words
that aren't included in the supplied dictionary to a custom user dictionary during a spell check session. 

When you click on the SPELL icon, prodigy mail automatically starts spell checking your message from 
the beginning. You can also re-position the cursor by clicking your mouse at any place in the message 
and the spell checker will analyze your message from this location until the end of the message or until 
you select Cancel Spellcheck 

A word not recognized by the spell checker will appear in the Not Found window and the Replace With 
window will display the first suggested alternative from the list in the Suggestions window. If this word is 
the one you want, select the REPLACE button. To Select a different word from the list, click to highlight it. 
(It will be now be displayed in the Replace With Window.) Then select the Replace button to use this 
word.

The image below contains hotspots that explain other spell check features. Move your mouse 
over the image and click when the cursor changes to a hand to learn more about the feature.

See Also:
Spell Check Options



Not Found Window
This word is misspelled in the current message



Replace With Window
This word is the suggested correct replacement for the incorrectly spelled word in the Not Found Window.
If you don't see a word you wish to use to replace the NOT FOUND word, you can type a new word in this
space and then select REPLACE. 



Suggestions (Not Found)
Click the Suggestions button and the spell checker will suggest a word (or words) which you can use to 
replace a misspelled word and display the choices in the Suggestions Window. 



Suggestions (Replace With)
Type a word that you know the partial spelling for in the Replace With window and then select the 
Suggestions button to display a list of choices that you can select from in the Suggestions Window.



Suggestions Window
This is a list of possible alternative words you can select from. If there is no suitable choice in this list, you
can manually type a different word in the REPLACE WITH WINDOW and then select the REPLACE 
button.



Ignore
Ignore this word and continue spell checking the message.



Ignore All
Ignore all words that are spelled in this manner in the current message.



Options
Display the spell checker Options dialog window.



Replace
Replace the word not found with the word highlighted in the suggestions window.



Replace All
Replace all words spelled in this manner in the current message with the word highlighted in the 
suggestions window.



Prompt Replace
Skip this word and go on to the next misspelled word.



Add to Custom
Add the word in the Not Found window to the custom user dictionary. The word you enter will be 
considered a correct spelling.



Cancel Spellcheck
Stop spell checking and return to the message you were writing.



Spell Check Options
Clicking on the Options button displays the following Window:

Automatic Suggestions: If this is unselected, you will have to click the Suggestions button each time you 
want to spell checker to suggest a word

Ignore Full Caps: When this setting is enabled, the spell checker will not stop on words typed in ALL 
CAPS and suggest mixed case corrections.

Allow Joined Words: When this setting is not enabled, words such as honeymoon would be identified as 
misspelled. When joined words are allowed, words such as honeymoon or wheelbarrow would not be 
identified as misspelled.

Recheck Typed Replaces: If you manually type in a word instead of selecting from the suggested word 
list, the spell checker will recheck the word. If you unmark this, these corrections will not be rechecked.




